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The SciCord ELN/LIMS Solution 
The SciCord solution is comprised of two parts, the SciCord Portal, and the SciCord Client.  

• SciCord Portal is designed for specific users to configure the system, by conducting 

administrative duties (ex. role assignment, reporting, configurations, etc.)  

• SciCord Client is designed for scientists, supervisors, and QA personnel to go through the 

workflow process of creating documents and/or samples, recording data, reviewing, and 

completing documents. There is a system of checks and balances between users that record 

information into documents, and users that review, approve, and complete documents.  

Together the SciCord solution and the customer maintain the integrity demanded of a compliant 

environment. 

 

U.S. F.D.A. CFR Part 11  
 

The SciCord Solution represents a ‘Closed System’ providing 

compliancy to U.S. F.D.A. 21 CFR Part 11.  

Part 11 applies in one of the following situations: 

• When electronic records are used instead of paper. 

• When persons make printouts but still rely on the 

electronic records in the computerized system to perform regulated activities. 

• Records submitted to the FDA, under predicate rules (even if such records are not specifically 

identified in agency regulations) in electronic format. 

• Electronic signatures intended to be the equivalent of handwritten signatures, initials and other 

general signings required by predicate rules. 
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SciCord Client  
The SciCord Client is initially accessed through the SciCord Applications/Client Installer section of the 

SciCord Portal. The user must have the Auth_WebUILogin permission to access the SciCord Portal and 

the Auth_ClientLogin permission to access the SciCord Client. The Permissions granted in the SciCord 

Portal allow a user further access based on their roles assigned in the Client. The permissions grant 

access to certain Documents, Samples and Resource entity functions. 

The SciCord Client is a rich internet application. It can create Documents, Samples, and Resources 

based on specific Templates where the user may record experimental data or sample management 

information. These entities can go through a workflow process from Created to Complete with various 

steps in between.  

Versioning and Hosting 
The SciCord Client provides visibility of the environment in the title bar. A user can access the full 

versioning information via the ‘Help’ tab, ‘About SciCord’ option in the drop-list of the ‘Settings’. 

 

 

 

 

 

 

 

System Configuration and Customization 
The SciCord Solution allows administrators to create and configure via the SciCord Portal ‘system 

parameters’, which the SciCord Client can use to implement specific Business Logic. Examples include: 

• Provide a system configuration defining a default list of "Audit Reasons".  

• Provide a system configuration to define whether "Audit Reasons" are mandatory.  
• Provide a system configuration to define "default Review classification" automatically   

assigned to a new document. 

• Product Name: SciCord Client 
• Version: <Ver> 
• WebApi version: <Api Ver> 
• TemplateApi version: <TemplateApi Ver> 
• Database version: <Database Ver> 
• Environment: <Environment Name & Business version> 
• Licensed to: <License> 
• Memory used by process: mb 
• Loaded Modules: lab equipment modules for equipment 

integration 
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Installation 
Note: The User must have access to the SciCord Portal to begin the SciCord Client Installation Process. 
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The SciCord Applications, SciCord Client Installer can be easily installed. There are 2 options for 

installation: 

• The SciCord Client Installer will download an executable file on to your local 

machine. Once downloaded, the user may open the file where the installer file will 

automatically place an icon for the SciCord Client on your desktop, and open to the login 

screen.  The name of the desktop shortcut will be ‘SciCord Client’.  

 *This is the easiest and best option for most users.  

 

• The SciCord Client MSI Installer will download an MSI file on to your local machine. The MSI 

file will automatically configure your machine with all the data needed to install, update, 

modify the SciCord Client.  

Registry Script will enable the ability to open SciCord Client from web pages.  

Silo Environment Login 

 

✓ Enter password 

✓ Click OK 

 

 

 

 

 

SciCord 
Client 
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SciCord Multitenancy Login Screen 

 

 A Multitenancy user will have a selection dialog appear. The user will need to:  

✓ Select target environment 

✓ “Remember” checkbox (system will automatically remember your target environment) 

✓ Click OK 

 

Multi Factor Authentication 
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SciCord Client: Home Screen 

Home Screen 

Once the User has logged into the SciCord Client, it will open to the “Home” screen.   

There are three visible panels in the SciCord Client Home screen:  

• Views Pane in the upper left  

• Open Entities Pane in the bottom left (directly under the Views Pane)  

• Home Pane selected is the large section on the right. Greeting appears along with recent 

entities (if any) that have been recently opened by the user.  

o Recent Documents, Recent Samples, and Search tabs are present with a full text 

search bar, a drop list for Document, Sample, Resource, and a Help button. 

  

A unique feature is that the User may re-size each of the panes by selecting the border and dragging it 

to the desired location. 
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*See the SciCord Icons and Meanings section for a description of each of the icons. 

 

 

 

SciCord Client: Home Functions 

Standard Functions 
There are shortcut functions that appear at the top of the Client’s Home screen regardless of which 

View the user has selected. By hovering over each of the functions the user will observe a dialogue 

(tooltip) that states what each shortcut function does.             

 

From left to right the Functions are:         

• Home: one click navigation to the Home dashboard 

• Quick Search Bar: once typing begins a drop list allows the user to select an entity to search for 

and enter in any numeric or text search for: 

o Document 

o Sample 

o Resource  

• Create a new Document: one click option to open New Document dialog  

• Create New Sample: one click option to open New Sample dialog 

• My Calendar: one click to open users Work Request schedule 

• SciCord Portal: one click navigation to open the SciCord Portal 

• Settings: a drop-list that allows a user to select

 
o Change Password 

o Save Preferences 

o Load Preferences 

o Active Content Link (available in Beryllium or newer release) 

o Help – will open the SciCord User Guide 

o About SciCord  

• Memory Usage Gauge: color coded system usage shown in mb 

• Minimize, Maximize screen  
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• Logout Icon: An error message will appear if any open entities need to be closed prior to 

logging out. 

• X: used to close the Home view panels current page (directly below the logout icon) 

• ^: used to collapse the Home ribbon 

Home Dashboard 
Upon login the user is greeted and can quickly look up any recently opened documents, samples, or 

search from a full text search bar (available in Beryllium or newer release).  

 

Search (available in Beryllium or newer release) 

Full text search bar allowing for a quick search of All, Documents, Samples, and Resources using the 

tabs on the search page. A Help button  is present to assist the user using strings with the 
following examples:  

 

A check box for “Only my site” is checked by default  
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A filtered search can also be performed using the drop list at the end of the search bar. 

 

A right or left click at the “…” reveals a dialog box to select an action: 

• Open for Edit 
• Open for Read Only  

• Open for Review 
• Open Status Dialog 

Once the action is selected the system will navigate the user to the selection. 

 

User may clear searches by right click of Recent Searches 
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Open Entities Pane 
There are five functions that are available in the 

Open Entities pane. Within the Open Entities 

pane, right click reveals each of the functions 

the user has access to use. Below is an image of 

the Views Pane functions.       

 

 

 

The right click within the Open Entities pane functions are dependent on the user permissions and 

actions performed:                

• Copy Resource: copy a resource reference (ex. REFDOC[10178] Blank v01_01) 

• Public URL…: creates a URL link to share. 

Drop list selection for length of Validity. Options to 

Copy to Clipboard, Generate a Short URL, and Close 

dialog. 

 

 

• Rename: to rename an entity  

• New Document: takes user to a dialogue to select the template for a new document 

• New Sample: takes user to a dialogue to create a new sample 
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Main ‘Views’ Pane 
Upon login, the user is greeted and shown a list of Recent Documents, Recent Samples, and Search 

accessed.  

   

Welcome Screen Home View 

Shown here is a close up of the Home tab functions on the Welcome screen. The Home tab is divided 

into 3 sections: Entities, User, and Other 

 

• Entities: allows for creation of New Document and New Sample. 

• User:  

o SciCord Portal one click access to the SciCord Portal login 

o Schedule: opens the users work request schedule 

o Settings: functions include: 

▪ Change Password - dialogue to change password 

▪ Save Preferences - save user desired selections for Welcome Screen 

▪ Load Preferences – load user desired selections for Welcome Screen 
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▪ Active Content Link- connects users’ phone to the Client. Use it as a Barcode 

scanner or send images (Available in 2.1 or newer version)  

▪  Help – downloads the SciCord User Guide 

▪ About SciCord – version information for SciCord Client 

• Other:  will open a dialog that allows for creation of New Data File, New Specification, New 

Message 

SciCord Client: Views 

Home Tab 
Home tab will vary depending on the type of view that the user has accessed. The Home tabs are 

grouped and divided into sections with icons and tool tips to guide the user to complete tasks.  

See Documents view example below: 

 

* The Manage and View sections of the Home tab are consistent for all views. 

Options Tab 
The Views Pane allows the user to quickly access from a list of views that the user may choose to 

include in their views list. Each of the pre-defined views are unique with their own filtering capabilities.  

Tip: The User may add multiple versions of the same View and rename them if they choose; this may be 

beneficial to the user if they would like to filter each of the views differently. 

Filters: In the Options tab the user can reveal a hidden pane that is on the right of the SciCord Client 

screen. To access the Filters and Columns function navigate to:  

 

• Options tab in upper toolbar 

• Hide is used to close the Filters, Columns, and Scheduling pane. 

• Filters and Columns icons are present may be used to sort and present data that is relevant to 

the User. The Default columns included on each specific ‘View’ pane vary depending on which 

View is selected. Below is an example image (from the Documents View) of the Filters and 

Columns that a User may choose to include in their various Views.  



 
SciCord ELN/LIMS Client User Guide - Beryllium R2.1.x 
Oct 3, 2022 

 

Page 17 of 103 

  

Filters View    Columns View  

 

• Dialogs and/or drop lists will prompt the user for criteria to set for Filters. A slider can be used 

for date criteria as well as a text box for numerical entry 

• Checkboxes are used to set criteria for Column filtering 

• Green ‘+’ symbol the user may add one or multiple filters 

• Red ‘---’ symbol the user may remove one or more filters  

Once the filters are set, the user may sort by selecting the Column header in the specific ‘View’ pane, 

which will order the data either ascending or descending. Example below:  

*Denoted by the downward arrow in the Date column, to display it is sorted in descending order. An 

upward facing arrow denotes ascending order.  
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• Scheduling used to create recurring reports that will 

be sent to logged in user email. Click the dots “…” 

next to “Schedule”; a dialog with drop list for the 

Cron Expression will appear to make schedule 

selection. 
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Views Pane  
There are five options available within the Views pane. Every user is allowed access to these five 

functions. Hovering the mouse over Add, Home, and Bulk Remove icons will reveal a tool tip description 

of each item.  

• Add: Drop list options used to create and add navigation views. Available views:  

o Documents 

o Data Files 

o Groups 

o Inventory 

Requests 

o Messages 

o Resources 

o Reports 

o Results 

o Samples 

o Sent Messages 

o Specifications 

o Work Requests 

o Templates 

o Users 

o My Approve 

o My Documents 

o My Data Files 

o My Reports 

o My Resources 

o My Review 

o My Samples 

o My Templates 

o My Users 

 

• Home: one click navigation to the Home dashboard 

• Bulk Remove: opens a dialog to remove multiple 

views  

• Move Up: select a view to move up in the list of views 

• Move Down: select a view to move down in the list of 

views 

• ^: used to collapse the Views ribbon 

Messages View 
Below is an image of the functions associated with the Messages View. There are three sections: Message, 

Manage, View. 

 

In the Message section, from left to right the functions are: 
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• New Message – a dialogue that allows a 

user to send a Message (Subject and Body) 

to users with access to the SciCord Client. 

Once typing begins, a selection of system 

users appears in the Recipients field to 

Add to the message. 

 

 

 

 

• Read Message – The user is allowed to 

Read the Message that has been selected. 

 

 

 

 

 

 

• Dismiss - The user can ‘Dismiss’ or mark as done on the Read Message dialogue or they can select 

the Dismiss icon as seen above in the Messages Functions ribbon. 

*Tip: The User may change their mail preferences by using the Options tab Filters. 

 

Messages default Filters and Columns 

*The Manage and View sections of the Home tab are consistent for all views. 

• Duplicate – Create a copy of the current view 

• Rename – user can rename the message view 

• Export View – allows the User to Save as an Excel file the Messages View 
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• Delete – removes the messages view 

• Refresh – allows the View page to be refreshed 

• Fetch All – shows the number of Messages included in the Messages View. When Fetch All is used, 

all messages will be displayed. If there are no Messages, then this will appear as ‘0/0’. 

 

Documents View 
The Documents View lists all the Documents in the SciCord Client.   

Icon and Lock column appear in the Documents View. The icon meanings are described: 

 

 

 

 

 

 

 

In the Lock column, the  will appear if the Document is currently in use by another user. If a user chooses 

to unlock the document, then a dialogue will appear: 

 

 

 

 

 

 

*Only users with Document_Unlock permission can perform this action. 

 

Icon Meaning 

 Created Status 

 Cancelled Status 

 Rework Requested Status 

 
In Progress Status 

 
Review Assigned Status 

 Approve Assigned Status 

 Complete Status 



 
SciCord ELN/LIMS Client User Guide - Beryllium R2.1.x 
Sep 28, 2022 

 

Page 22 of 103 

 

 

Document view illustrating Documents view Lock icon 

 

The Home tab Documents view functions (from left to right) are: 

 

*Hover the mouse over each icon to view the tool tip for each. 

• New: Document_Edit permission required 

• View: Document_View permission; opens document with a ribbon stating: 

o “READ ONLY VIEW Changes to the document will not be persisted.” 

• Edit: Document_Edit permission required 

• Clone: Document_Clone permission; clones selected document  

• Review: Document_Review permission required; user is assigned to Review the Document 

• Status: Document Status Update permissions required.  

• Unlock: Document_Unlock permission required 

• Message: Create a Message for the Selected Document  

• Attachments: download selected document attachment or attachments 

• Tags: opens dialog to create a tag for entity. Add, Set, or Remove tags. 

 

 

*The Manage and View sections of the Home tab are consistent for all views. 

 

• Duplicate: Create a copy of the current view 

• Rename: Renames the Document view  



 
SciCord ELN/LIMS Client User Guide - Beryllium R2.1.x 
Sep 28, 2022 

 

Page 23 of 103 

• Export: Allows the User to Save as an Excel File the Documents View 

• Delete: Deletes the Document view currently displayed 

• Refresh: Refresh Documents List 

• Fetch All shows the number of Messages included in the Messages View. When Fetch All is used, all 

messages will be displayed. If there are no Messages, then this will appear as ‘0/0’. 

The Options tab Documents view functions (from left to right) are: 

 

*Hover the mouse over each icon to view the tool tip for each. 

• Hide: using this icon will close the filters/columns display 

• Filters: filter data to locate or narrow to locate an entity 

• Columns: checkboxes used to reveal columns to be shown in entity view 

• Scheduling: See page 14 for explanation 

• Bookmarks Add: Add to MyDocuments– Allows the user to add the selected Document to their 

personal ‘MyDocuments’ View 

• Groups Add: Add the selected Document(s) to one or more Groups 

• Groups Remove: Remove the selected Document(s) to one or more Groups 

The user may add any Filter to the View and any additional column. 

 

DataFiles View 
The SciCord Client supports the storage of generic files, called ‘Data Files’ throughout the system. Data Files 

may be uploaded to the system using the SciCord Client or the SciCord Portal. Once a Data File is added to 

the system it can be used as an attachment in any document and may be shared with other users. 
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The Icons present in the Data Files view are from left to right: 

 

 

• Upload: DataFile_Create permission required; A dialogue will appear allowing the user to Upload a 

File, Set Tags, and provide any Notes 

• Properties: DataFile_Edit permission required; user may change the File Name, Folder, Description, 

Tags, and Notes of a Data File 

• Delete: DataFile_Delete permission required; User may Delete any Data File from the System 

• View: DataFile_View permission required for browsing, inspection, and download of Data Files 

• Download: The User may Download the Data File  

• Signatures: view and manage electronic signatures of Data Files 

• History: view history of data files 

• Tags: Add, Set, Remove Data File tags; depending on the action to perform the following 

permissions will be required: DataFile_Create, DataFile_Delete, DataFile_Edit, 

DataFileFolder_Management 

*The Manage and View sections of the Home tab are consistent for all views. 
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Below are the Filter and Column choices provided to the User for sorting Data Files and presenting 

information that is relevant to the User. 

 

Filters View   Columns View 

 

Groups View 

The user can define and manage ‘Groups’ for the purpose of assigning and filtering entities. Groups 

are defined in the SciCord Portal by an Administrator, and include the Group Name, a Description, 

Active flag, and Customer flag. 

In the SciCord Client, Users will be able to add, or remove, Documents to all Groups that they are a 

member of. The user will not be allowed to add, or remove, any Documents to Groups that they 

are not a member of. 

The Groups View shows to the user which Groups that they are a member of. 
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The Icons that are associated with the Groups View are, from left to right: 

 

  

 

*The action items listed in Groups view; Home and Options tab, Manage, View, and Options sections are 

consistent for all views 

Below are images of the Filters and Columns available to the User in the Groups View: 

 

Filters View    Columns View 
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MyApprove View 
The MyApprove View is a special implementation of a Documents view. This view displays Documents in 

‘ApproveAssigned’ status only, where the assigned approver is the current active User.  

A user that is assigned approver of a document, meaning in ‘ApproveAssigned’ status, the document will 

appear in the ‘MyApprove’ View. 

 

 

*Although many of these icons are viewable, only a few are selectable depending on the users’ actions and 

set permissions  

Below are the Filters and Columns that a user may use to sort and display the details of the MyApprove 

View. 

  

Filters View   Columns View 
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Bookmarking Function 
This function allows a user to create a saved shortcut list for the logged user. This feature is in the Options 

tab, Add Bookmarks, and contextually when focused on an entity.  

Bookmarks are available for the following views:  

• Documents 

• Samples 

• Data Files 

• Resources 

• Templates 

• Users 

• Reports 

Once an item is bookmarked it can be viewed in the users ‘My’ view. (ex: My DataFiles, MyDocuments, etc.) 

 

Toolbar view 

 

Contextual view 
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MyDocuments View 

The ‘My’ View is a bookmarking functionality. The user can quickly access and manage Documents 

that have either been created by the user, or that they decided to include in their MyDocuments 

View by using the Bookmark function. 

 

Below are the icons associated with the Home and Options tab MyDocuments View 

 

 

*The Home and Options tab icons available are consistent for Document and MyDocuments views.  

 

 

 

 

 

 

 

Below are images of the default Filter and Column settings that a user may use to sort and display the 

details of the MyDocuments view. 

 



 
SciCord ELN/LIMS Client User Guide - Beryllium R2.1.x 
Sep 28, 2022 

 

Page 30 of 103 

  

Filters View   Columns View 

  

MyDataFiles View 
The ‘My’ View is a bookmarking functionality. Using the MyDataFiles function the user can include the 

generic DataFiles into their ‘My’ View.  

The Bookmark/Add icon appears in the Options tab DataFiles toolbar, or the user can right-click on any Data 

File and an option to Bookmark will be available. 

MyResources View 
The ‘My’ View is a bookmarking functionality. The user can quickly access and manage Resources that have 

either been created by the user or that they decided to include in their MyResources View. 

The Bookmark/Add icon appears in the Options tab DataFiles toolbar, or the user can right-click on any 

Resource and an option to Bookmark will be available. 
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MyReview View 

The MyReview view is a special implementation of a Documents View. This view displays documents in 

ReviewAssigned status only, where the assigned reviewer is the current active user. 

The ‘My’ View is a bookmarking functionality. The user can quickly access and manage Documents assigned 

to them for review. 

 

 

 

 

 

 

 

 

 

The Icons in the MyReview View toolbar can be seen below: 
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Important Icons are the ‘Open Document for Review’, the ‘Modify Document Status’, and potentially the 

‘Create a message for the selected Document’. These icons allow the Reviewer to: 

• open the Document to complete Review 

• to modify the Status 

• and to write a message to the Users involved with the Document 

Below are the Filters and Columns available for selection in the MyReview View: 

  

Filters View   Columns View 
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My Reports View 
The ‘My’ View is a bookmarking functionality. The user can quickly access and manage Reports that have 

either been created by the user, or that they decided to include in their MyReports View. 

By using the Bookmark function the user can include Reports into their ‘My’ View. The Bookmark icon 

appears in the Reports toolbar, or the user can right-click on any Reports in the Reports View and an option 

to Bookmark will be available for selection. 

*The action items listed in MyReports view; the Home and Options tab, Manage, View, and Options 

sections are consistent for all views 

 

  

Home toolbar, Reports section, functions:  

• Manage Reports: action will open the SciCord Portal Reports Index page 

• Details: action will open the SciCord Portal Report Details page to show Report Name, Report Type, 

Description, Report File – Launch option, Rdlc Name, Report File Name, Report File Version, Status, 

Is Admin checkbox, and Version information. 
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• Launch: action will open the SciCord Portal 

Report Configuration details with fields for 

Date From, Date To, drop list for Category, 

drop list for Site, Show button, Report File 

Name, Report File Version, Report File 

Upload Date, and Report File Uploader.  

 

 

 

 

 

 

 

The Filters and Columns for MyReports Views are displayed here:  

  

Filter view   Columns view 

 

MySamples View 
The ‘My’ View is a bookmarking functionality. The user can quickly access and manage Samples that have 

either been created by the user, or that they decided to include in their MySamples View. 

By using the ‘Add to MySamples’ function the user can include Samples into their ‘My’ View. The ‘Add to 

MySamples’ icon appears in the Samples toolbar, or the user can right-click on any Sample in the Samples 

View and an option to ‘Add to MySamples’ will be available for selection 
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MySamples view with contextual view menu options 

 

Below are the icons present in the MySamples View: 

 

From the MySamples Toolbar the User can: 

• New – create a new sample 

• View a Sample 

• Clone a sample 

• Modify Sample Status 

• Label – create a label for sample 

• Send Message about the Sample 

• Attachments – download an attachment for selected sample 

• Specification Details with options to Save, Add, Close, or Refresh, or Export. User will also have the 

option to Toggle the details of multiple Specification 
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• Work Request Details - with options to Save, Add, Close, Refresh, Export, View and Edit 

(dependent upon SampleWorkRequest_Edit permission) Sample 

• Work Request Schedule – displays a calendar view of Work Requests for selected Sample 

• Inventory Details - Home and Tools tab view with options to Close, Refresh, Toggle, Export 

Transactions and Requests 

• Inventory Schedule – Calendar view of Inventory Transactions 

*The action items listed in MySamples view; Home tab, Manage and View sections are consistent for all 

views  

Options tab functions: The user may also Remove Bookmark and Add or Remove Samples from the 

MySamples Groups View. 

Below are the Filters and Columns that may be selected by the user to sort and display MySample Details: 

  

Filters View   Columns View  

MyTemplates View 
The ‘My’ View is a bookmarking functionality. The user can quickly access and manage Templates that the 

user decides to include in their MyTemplates View. 

The user can go to Options tab, Bookmarks Add or, right-click on any Template in the Template View and an 

option to Bookmark will be available to add the selection to MyTemplates view. 
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The MyTemplates Toolbar: 

• Help – if a Help document is associated to a template this action will open the document 

• Duplicate – create a copy of the current view 

• Rename – Rename the templates view shown in the Views pane 

• Export – export the MyTemplates view as an excel worksheet  

• Delete – action to delete the MyTemplates view currently shown 

• Refresh – refreshes the current view 

• Fetch All - the current # of templates being shown/the # of templates in the SciCord Client 

*Options tab functions are consistent with other ‘My’ views. 

The Filters and Columns available to the User for the MyTemplates view are seen below: 
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Filters View  Columns View 

MyUsers View 
The ‘My’ View is a bookmarking functionality. The user can quickly access and manage Templates that the 

user decides to include in their MyUsers View. 

The user can go to Options tab, Bookmarks Add or, right-click on any User in the MyUsers View and an 

option to Bookmark will be available to add the selection to MyUsers view. 

The Schedule function will open a calendar view of the users Work Request schedule. All other functions are 

the same as other ‘My’ views.  

 

 

Below are the Filters and Columns available to the User to filter and display User details. 
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Resources View 
The Resources View implements a specific filtered and customizable view for Resources that are available in 

the SciCord System. Users may add new Resources views and rename at their pleasure; this can be an 

advantage when the user wants to create a filtered list of Resources. Resources are initially restricted to the 

User’s Site. These Resources can be copied to the Client Clipboard and referenced within Documents on the 

Client. 

 

Below is the Resources View Toolbar. 
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The Resources Toolbar includes, from left to right, functions: 

• Edit – action will open the source document for edit 

• View – action will open the source document for view 

• Labels – action will print labels for selected resource 

• Inventory – action will open the inventory and associated transactions for the resource 

*All functions in the Manage, View, Options, and Bookmarks are consistent within the SciCord Client. 

 

 

 

Below are the Filters and Columns that may be used by the User to sort and display Resource details. 
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Filters View  Columns View 

 

 

 

 

 

 

 

 

 

 

 

Samples View 
The Samples view implements a specific filtered and customizable view for Samples that are in the SciCord 

System. The Samples that appear in the Samples View are initially restricted to the User’s Site. 
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Samples View shown with contextual menu options 

The Samples View Toolbar includes the following Icons: 

  

• New – action to create a new sample 

• View – action to view a selected sample 

• Edit- action to open sample for edit 

• Clone – action to clone the selected sample 

• Review – if the user is assigned as sample reviewer, this action is enabled 

• Status – action to modify the sample status 

• Unlock – action to unlock a selected sample 

• Label – print labels for selected sample 

• Message – create and send messages for selected sample 
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The Specifications, Work Requests, Inventory, Manage, and View sections of the Home tab are consistent 

and previously covered in the MySamples view. 

Below are the Filters and Columns that may be used by the User to sort and display the Sample details 

   

Filters View  Columns View 

 

 

Templates View 
The Templates View is a list of all the Templates in the SciCord System that are available to the user. The 

View will show the Status of the Template as Created, Active, Validated, or Inactive. The user can create 

multiple Templates Views and rename them as the user pleases.  
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The MyTemplates Toolbar: 

• Help – if a Help document is associated to a template this action will open the document 

• Duplicate – use to create a copy of the current view 

• Rename – Rename the templates view shown in the Views pane 

• Export – export the MyTemplates view as an excel worksheet  

• Delete – action to delete the MyTemplates view currently shown 

• Refresh – refreshes the current view 

• Fetch All - the current # of templates being shown/the # of templates in the SciCord Client 

Below are the Filters and Columns that the User may use to sort and display the Template details. 

   

Filters View   Columns View  
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Users View 
The Users View implements a specific filtered and customizable View of the Users that are in the SciCord 

System. 

 

Below are the toolbar functions associated with the Users View. 

  

• Schedule – action will open the selected users Work Request schedule. 

*All other sections in the Home and Options tab are consistent with MyUsers view previously discussed. 

Below are the Filters and Columns associated with the Users View. 
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Filters View  Columns View  

Specifications View  
The Specifications view implements a specific filtered and customizable view for Specifications that are in 

the SciCord System. The Specifications that appear in the Specifications View are initially filtered to the 

User’s Site. 

The View will show the Entity ID, Version, Name, Manual Spec ID, Description, Product Code, Status, Review 

Classification, Date and Creator of the Specification. The user can create multiple Specification Views and 

rename them as the user pleases.  

 

Specification’s view shown with contextual options 
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The Home toolbar functions are -  

Specification:  

 

• New – Dialog for new specification includes, 

Name, Manual Spec ID, Product Code, Description, 

Review Classification drop list with selections for 

SelfReview, PeerReview, PeerReviewApprove. An Open 

checkbox to have the Specification open for edit.  

 

 

 

• Clone – opens a dialog to select and clone a sample  

 

 

 

 

 

 

 

 

 

 

• Open – open the specification for edit has fields for:  

o Toolbar options for: Specification section - Save, New Version, Close, Refresh and Review 

Classification section with drop list option to change the review classifications. A tab with the 

Version is located above the specification name. 

o Information on the left side of the Specification view pane:  

▪ ID/Entity ID 

▪ Classification 

▪ Name 

▪ Manual Spec ID  

▪ Description 

New Specification dialog 
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▪ Product Code 

▪ Attachment – Upload from local file or a Data File 

▪ URL – option to Change the URL button  

▪ Notes – free text field  

 

Open Specification showing all attributes 

 

 

*All other sections in the Home and Options tab are consistent with all views. 

Below are the default Filters and Columns associated with the Specifications View: 
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Filter’s view Columns view  

 

 

 

Work Requests View 
The Work Requests view implements a specific filtered and customizable view for Work Requests that are in 

the SciCord System. The Work Requests that appear in the Work Requests View are initially filtered to the 

User’s Site. 

The View will show the Entity ID, Test Analysis, Sample, Sample Description, Method, Assignees, Status, 

Experiments, Comments, Scheduled From, Scheduled To, Due Days, Overdue days, Replicates, Hours 

expected, Hours spent, Date, Created By, Last Modified By. The user can create multiple Work Requests 

Views and rename them as the user pleases.  

 



 
SciCord ELN/LIMS Client User Guide - Beryllium R2.1.x 
Sep 28, 2022 

 

Page 50 of 103 

 

Sample Work Request View 

  

The Home toolbar functions are -  

• Work Request Section –  

o View: selection will open the Work Request in read only mode 

o Delete: action will open a dialog asking if the user is sure they want to delete the selected 

work request. Button to select Yes or No.  

• Assignments Section -  

o Add: selecting a work request select Add will open a dialog to select a user to add to the 

Work Request. A checkbox is available for “Only my site” 

o Set: action will replace a user that is assigned to a Work Request with another user by 

opening a dialog box to select a different user.  

o Clear: will reset all assignees associated to the selected Work Request 

• Sample Section - 

o View: opens the sample in read only mode 

o Edit: opens the sample for edit 

• Document Section -  

o View: opens the document in read only mode 

o Edit: opens the document for edit  

*All other sections in the Home and Options tab are consistent with all views. 
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Below are the default Filters and Columns associated with the Work Requests View: 

  

Filter’s view  Column’s view 

 

Reports View 
The Reports view implements a specific filtered and customizable view for Reports that are in the SciCord 

System. The Reports that appear in the Reports View are initially filtered to the User’s Site. 

 

Report’s view 



 
SciCord ELN/LIMS Client User Guide - Beryllium R2.1.x 
Sep 28, 2022 

 

Page 52 of 103 

 

  

The Home toolbar shows:  

• Reports section: 

o Manage Reports - opens the SciCord Portal Reports Index 

o Details: opens the SciCord Portal Report Details page of the selected report 

o Launch: opens the SciCord Portal report configuration page and a Show button. 

*All other sections in the Home and Options tab are consistent with all views. 

Below are the default Filters and Columns associated with the Reports View: 

 

Filter’s view  Column’s view  

 

 

Sample Inventory Requests View 
The Sample Inventory Requests view implements a specific filtered and customizable view for Sample 

Inventory Requests that are in the SciCord System. The Sample Inventory Requests that appear in the 

Sample Inventory Requests View are initially filtered by Status. 
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Samples Inventory Request view shown with contextual menu options 

  

 

 

 The Home tab options are:  

• Inventory section –  

o View – opens a dialog to show the request details 

o Inventory – opens the sample inventory requests page 

o Schedule – opens calendar view of the sample inventory requests 

o Label – opens the print labels dialog, options to select Label Size, create Custom Sequence, 

Print or Close 

o Sample section – Edit or View the sample inventory request 
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*All other sections in the Home and Options tab are consistent with all views. 

Below are the default Filters and Columns associated with the Sample Inventory Request View: 

  

Filter’s view  Column’s view  
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Samples Results View 
The Sample Results View implements a specific filtered and customizable view for Sample Results View that 

are in the SciCord System. The Samples Results View that appear in the Samples Results View are initially 

filtered by the user’s site and Only Pending. 

 

Sample Results view shown with contextual menu options 

  

The Home toolbar options are:  

• Inventory section:  

o Edit Sample – if sample is not in ‘Available’ status, user can edit the sample 

o View Sample – opens the sample in read only mode 

• Document section: 

o Edit Document – if document is not in ‘Complete’ or ‘Cancelled’ status, user will be able to 

edit the document 

o View Document – opens the document in read only mode 

*All other sections in the Home and Options tab are consistent with all views. 

Below are the default Filters and Columns associated with the Sample Results View: 
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Filter’s view  Column’s view  

 

Specifications  

Functions 
A user is able manage sample specifications if they have the Sample_Edit permission. There are sliding panes 

available to expand your views of the specification.  

The user can create a specification, add samples to the specification, create rules, create versions, view 

sample results, show the history of the specification, and all signatures associated. An export of all the data 

to an Excel spreadsheet is also available.  

 

 

 

 

The Home toolbar functions are shown below:  
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Specification:  

• New – Dialog for new specification includes, Name, Manual Spec ID, Product Code, Description, Review 

Classification drop list with selections for SelfReview, PeerReview, PeerReviewApprove. An Open 

checkbox to have the Specification open for edit.  

• Clone – opens a dialog to select a sample to clone 

 

 

 

 

 

 

 

 

 

        Clone sample dialog 

 

• Open – open the specification for edit has fields for:  

o Toolbar options for: Specification section - Save, New Version, Close, Refresh and Review 

Classification section with drop list option to change the review classifications. A tab with the 

Version is located above the specification name. 

o Information on the left side of the Specification view pane:  

▪ ID/Entity ID 

▪ Classification 

New Specification dialog 
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▪ Name 

▪ Manual Spec ID  

▪ Description 

▪ Product Code 

▪ Attachment – Upload from local file or a Data File 

▪ URL – option to Change the URL button  

▪ Notes – free text field  

 

Shown here is a Created Specification for edit  

o Information on the right side of the Specification view pane:  

▪ Tabs for Rules, Samples, History, and Signatures 

Rules 
Create a Specification Rule dialog:  
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• Measurement – selecting the “…” will open a Select 

Measurement dialog. These measurements are set up in the 

SciCord Portal Laboratory Configurations 

• Rule Name is automatically populated once the 

Measurement is selected.  

• Report Label – free text 

• Display Order – numeric values to assign order 

• Method - selecting the “…” will open a Select Resource 

dialog. The methods used are created from resource 

documents in the Client. 

• Verify only results matching attributes – checkbox to 

activate attributes set in the SciCord Portal Laboratory Configurations 

• Comments - selecting the “…” will open a dialog to expand the comments box 

• Rule Type – Numeric or Text 

If Numeric Rule Type is selected:  

o Checked against – drop list values set in the SciCord Portal Laboratory Configurations 

o Number of decimal places 

o Criteria Error – drop list selection of “≤” or “<” and a text box display to 2 decimal places 

o Criteria Warn - drop list selection of “≤” or “<” and a text box display to 2 decimal places 

o Criteria Warn - drop list selection of “≥” or “>” and a text box display to 2 decimal places 

o Criteria Error - drop list selection of “≥” or “>” and a text box display to 2 decimal places 

• If Text Rule Type is selected:  

o Checked against - drop list values set in the SciCord Portal Laboratory Configurations 

o Criteria Expected values – selecting the “…” will open a dialog to expand the text box 

o Acceptance values - selecting the “…” will open a dialog to expand the text box 

• Data input instructions – checkbox to activate for Measurements with Instruction Label Attributes 

defined in the SciCord Portal Laboratory Configurations. Selecting the “…” will open a dialog to expand 

the text box 

Buttons to Create and Continue, Create, and Cancel. Once the Specification is created      
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Specification Rule shown with contextual menu and all available columns and data. 

Once a specification has been created the available buttons are:  

• Create- create a rule dialog opens 

• Create from – copies a rule from a selected rule and opens the dialog to create it  

• Edit  

• Delete 

• Disable/Enable – toggles the flag to enable or disable a specification 

• View – opens for view  

Samples  
The Samples tab is available to Add, Remove, Edit, and View the samples for the specification. The user may 

use the toolbar options or the contextual menu options to complete these tasks.  
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To ‘Add’ samples to a specification:  

✓ Select Add button 

✓ Select Samples dialog opens 

 

✓ Select sample(s), using Filters if needed to Add To Selection Queue.  

✓ Click OK, the Specification Samples tab is updated to show the sample selected  

To Remove the sample from the Specification 

✓ Select the Sample 

✓ Click Remove 

✓ A message appears asking if you are sure you want to 

remove the selected Samples, click Yes or No 

✓ The sample has been removed 

 

 

To Edit the sample associated to the Specification 

✓ Select the Sample 

✓ Click Edit 

✓ Dialog opens showing the Sample Properties, toolbar options  
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Sample Properties Home tab shown with toolbar options 

 

Sample Properties Tools tab with subpanel toggle to reveal subpanel options – Aliquots, History, Signatures, Attachments 

To use the View button, this action will reveal the Sample Properties shown with yellow ribbon to designate 

the user is viewing in Read Only View 
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History 
The Specification History tab has checkboxes for System, Specification, and Rules. These checkboxes filter 

the Target Column data. Columns for Date, Author, Target, Event Type, Property, Value, Previous Value, 

AuditID 

 

Signatures 
This Signatures tab will display all signatures associated with the Specification. There are columns to show 

Signature Date, Created By, Signature Type, and Signature Meaning. 

 

Specification signatures show the time and date of the signature, the user id of the Reviewer and the Approver. 

Create New Version  
Using the New Version button in the toolbar will create a copy of the previous version. The user can then go 

in and manage any updates or changes needed.  
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Version 2 of the Specification is denoted in a blue tab located under the New Version button 

Data Files 
Dependent on User permissions, options may Upload, Delete, View, view Properties, Download, view 

History, create a public URL, View or Manage Signatures of Data Files.  

  

Document Editor 
A User is able open any Document for Edit if they have the Document_Edit permission. After a Document 

has been edited and closed an electronic signature will be required. 

Functions 
Document Editor Functions appear when the User opens a Document for Edit or Review, however only 

changes that are made to a Document in Edit mode will be saved. Many of these functions are like functions 

in Excel and Word. Below are images of the Document Editor Toolbar. 

*See the SciCord Icons and Meanings section for a description of each of the icons. 

 

Documents View Home tab  

 

Document editor Home tab 
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Document editor Insert tab 

 

Document editor Format tab 

 

Document editor Review tab 

 

Document editor Tools tab 

Create a Document 
To create a Document: 

✓ select the New Document icon (  ) in the system toolbar or in a (My)Documents View 

✓ A New Document dialogue will appear.  

✓ The New Document dialogue provides buttons for a view of either ‘All Templates’ or ‘My 

Templates’ 

✓ Filter bar can be dynamically filtered by recording text 

✓ Select a template from the list 

✓ Attributes, Tags, Groups can be added to the document. These add additional filters for the 

document being created. 

✓ Record a Description for the selected Template 

✓ Set the Review Classification (SelfReview, PeerReview, PeerReviewApprove).  
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✓ Open Document checkbox is checked by default. This will automatically open the user 

document 

✓ After ‘OK’ is selected the document will be opened if the ‘Open Document’ flag is selected. 

 

 

 

Read Only Mode document  

Note: When a Document is opened for Read-only the Document will open with a yellow ribbon (as seen on 

the image above). This denotes that the Document is in Read-only mode and no changes will be saved. 
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File Attachments  
File attachments may be inserted, viewed, or downloaded. When a document is open for edit:  

✓ Files may be inserted as an attachment using the Insert tab, File Attachment icon, from local 

file or a data file.  

✓ Files can be drag and dropped into a document. 

✓ Contextual Insert Attachment, Insert Data File 

Documents View Subpanels 

 

Subpanels can be accessed by pulling up on the gray bar “…..” at the bottom of the client interface.  

All Documents in the SciCord Client have Subpanels; however, each subpanel varies depending on the 

structure of the Template and whether there is any instrument interfacing. Some basic features include:  

 

Subpanel – Info tab 
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Subpanel – Instruments tab 
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Subpanel – Resource Tool 
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Subpanel – Barcode Tool 
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Subpanel – Aliquot’s tab 
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Subpanel – Work Request tab 
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Subpanel – Data tab  
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Subpanel – Attributes tab 
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Subpanel – History tab 
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Subpanel – Review Alerts tab 
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Subpanel – Signatures tab 
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Subpanel – Notes tab 
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Subpanel – Resources tab 
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Subpanel – Attachment’s tab 

Additional panels may be present such as Training Assignments or Moisture Interface depending on context. 

• Info: displays information such as the document’s description, original template, author, review 

class, status, etc. 

• Resource Tool: allows the user to view Resources based on Categories or to manually Search based 

on Name or Document Number and to Record the Resource into the opened Document. 

• Instruments: The user can connect to an instrument that is recorded in the Document, retrieve 

readings from the instrument and view the Calibration Due Date, it’s last check date and the 

outcome. 

• Barcode Tool: The user may record a resource into the Document by using the Barcode Tool 

• Aliquots: The user can review the Aliquots (Samples) that have been associated with the Document. 

• Data: The Data tab lists all the Data from the Document that is being extracted. The Data includes 

Aliquots, Test (Analyses), Method, Method Version, Measurement, Value and Raw Value, the Unit, 

and configurable Attributes 1-5. 



 
SciCord ELN/LIMS Client User Guide - Beryllium R2.1.x 
Sep 28, 2022 

 

Page 81 of 103 

• Attributes: Metadata, configured by the Template Developer, that is stored by the document and 

viewable to the user. Such metadata may also be used for reporting purposes. 

• History: The user can view the history of any cell, worksheet, or workbook. Record of all dates and 

times of any document creation or modifications.  

• Review Alerts: The user may view Review Alerts that are associated with the document. This 

function could lead a reviewer to potential issues with a document. 

• Signatures: each electronic signature that is conducted within the document is listed; the Date, 

Signee, Signature Type and Meaning are recorded. 

• Notes: allows a user to make Notes/Comments in any cell of the document. The user may create 

new Notes or Append old Notes. Each Note contains data on who it was Created By, the Date, the 

Note Text and Note Location. Once the document is in Complete status, the notes will disappear. 

• Resources: a web linking any Resources used to the current Document. 

• Attachments: this dialogue screen shows any item that is attached in the document. It provides 

details on the Description, Date recorded, Created By which User, and Source File. 

Other Items that can be included in the Subpanel include: 

• FD10 Interface, Raman Interface, GeoPyc Interface, Sympatec Interface, DVS Interface, and Usage 

Log 

Structured Data 
Structured Data is available and can be configured based on customer specific business logic. Structured 

Data consists of System Configuration information, such as Lists, Data extracted from Documents in the form 

of Analysis and Component Results, and Document Attributes in the form of ConfigAttribute Results.  

Sample Editor 

Properties 
A user must have the Sample_Edit permission to Open a Sample for Edit and the Sample must be in either 

Created or In Progress/Rework Requested Status. A User may not Edit a Sample that is in Cancelled, Review, 

Approve or Available Status. The Sample Edit view opens onto the Sample’s Properties tab. On the Left Panel 

of the Sample Properties are the Mandatory Sample Attributes that are configured using the SciCord Portal. 

The Right Panel contains Sample Properties that are Optional and configured using the SciCord Portal. Only 

the Attributes on the Right Panel can be Edited after the Sample has been Created.  

Below are examples of Attributes that can be configured in the Portal as either Mandatory or Optional. 
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Sample Work Requests 
A user with the Sample_Edit permission may ‘Add’ Work Requests to a Sample. Work Requests are 

configurable using the SciCord Portal and a Method, Location, and Comment may be associated with each 

individual Work Request. The right-hand pane of the Work Requests interface provides a table for 

associated Aliquots, representing testing performed for a specific Sample and Analysis. The user may select 

and View the Document. 

 

The Subpanel shows the User the Attachments, Aliquots, History, Comments, and Signatures tabs. 

Sample Results 
The Sample Editor provides a Results tab that is a view of the Structured Results/Data as related to the 

current Aliquot. An ‘Export’ function allows the User to save the listed results as an Excel (.xlsx) or Comma 

Separated Values (.csv) File on their machine. 
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Samples Subpanel 
In the Sample Editor, the Subpanel shows the User the Attachments, Aliquots, History, and Signatures tabs 

of the selected Sample.  

 

Attachments 
A User may browse Attachments and Add Attachments up to 20MBs. Attachments may also be added to the 

Sample from DataFiles. The User may Append the Attachment Description by typing into the Append bar 

and then selecting ‘Append’. Although a User may Remove an Attachment, they can also easily Restore an 

attachment by ‘Include Removed’, selecting the Removed Attachment, and then selecting the 

‘Remove/Restore’ button. 
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Aliquots 
Aliquots are instances where a parent Sample is introduced into a Document. Each single association 

between a Sample and a Document will represent a unique Aliquot ID. The User may either View or Edit the 

Document that the Aliquot is associated with by selecting the View/Edit buttons. 

 

 

History 
The History tab provides visibility and partial management of auditable events performed on a Sample. In a 

Sample Open for Edit a User can select events from the History table and append a reason via the 

‘AddToReason’ button which will appear in the Reason column of the table. 
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Signatures 
The Sample Editor supports Digital Signatures for Author(s) and Reviewer(s). The Signatures tab displays all 

Signatures applied to a Sample, including final Approval signatures of Samples with ‘PeerReviewApprove’ 

classification and ‘Complete’ status. The user may also select a pending signature by a user as Author or 

Reviewer and sign by providing the proper password and meaning. 
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Sample Inventory 
The SciCord Solution supports Samples Inventory management and custody tracking across Samples’ family. 

Inventory transaction can be booked and planned through previously entered inventory requests. The 

Samples Family is defined through the Parent-Sample relationship. A Sample may have multiple children and 

each child may have other children as well. 

A user must have the SampleInventory_Edit, SampleInventory_View, SampleInventoryRequest_Edit, or 

SampleInventoryRequest_View permission to be able to open the SampleInventory view. Depending on the 

permission granted the user will be able to edit or view the Inventory Requests and Inventory Transactions. 

A user with any of the above-mentioned permissions will be able to export all Inventory Requests for all the 

Samples as an Excel or CSV file. A user with the SampleInventory_Edit or SampleInventory_View permission 

may export all Inventory Transactions as an Excel or CSV file. 

There are a couple of ways to access the Sample Inventory: 1) From a ‘Samples’ or ‘MySamples’ View, the 

user may select a Sample, and in the Sample Toolbar, click the ‘Open the Sample Inventory’ button  ; 2) If 

a Sample is opened in either Edit or Read Only Mode, the user may click the ‘Open the Sample Inventory’ 

button in the toolbar . 

 

 

Inventory Transactions 
Inventory Transactions are used to record actual movements from or into the Inventory. The Transaction 

can either be recorded from scratch or created following a previous Inventory Request (see Inventory 

Requests). In the latter case, the system will keep the link between the Request and the Transaction. To 

create Inventory Transactions a User must have the SampleInventory_Edit permission.  

 

A user may set the Transaction Date, set an 

Event (Pick, Return, Fill, TransferIn, 

TransferOut, Disposal), set an Amount to be 

removed or added to the current amount, 

record an Analyst the amount was 

dispensed to or returned from, record any 

Comments or any Attachments. With each 
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transaction the SciCord System will 

automatically record the user who recorded 

the data, local time, and system timestamp. 

 

 

A user may also Transfer material 

between Samples. A user with the 

SampleInventory_Edit permission may 

conduct a Transfer. A Transfer will 

generate two transactions: one removing 

material from the Source and the other 

adding material to the selected ‘Transfer 

to’ Sample. 

 

The Transactions may be exported as either an Excel file (.xlsx) or as a CSV (.csv) file. 

 

Inventory Requests 
Inventory Requests are made by users, generally Scientists, to request a quantity of a particular Sample or to 

book a restitution. Inventory Requests track only the request of the material, while the actual movement 

from or into the inventory will be recorded by creating corresponding Inventory Transactions. Only the User 

with the SampleInventory_Edit or SampleInventoryRequest_Edit are able to create Inventory Requests and 

mark/unmark existing requests as ‘Complete.  

 

When creating a Request a user may set a Due Date, select an Event (Pick/Return), set an amount to be 

added (Pick) or removed (Return), make a comment, or record an attachment. As each Request is completed 

the SciCord System will automatically record the user who made the request, the local time/system 

timestamp, and allows a User to send notification of the Created Request to the interested parties. The 

Requests may be exported as either an Excel file (.xlsx) or as a CSV (.csv) file. 
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Enhanced Location management 

Ability to define nested locations. A location can be a building, a room, an equipment, a box, etc. 

A location will have the following attributes: 

• Name, mandatory and unique across the system 

• Description, optional 

• Barcode, optional and unique across the system 

• A parent location - mandatory 

• A position relative to the parent location - see below 

• A flag that mandates each child to this container to have a position set 

• A flag that allows (or not) to have more than one child in the same position 

 

 

Inventory Change Location  
 

 

 

 

Document and Sample Life Cycle 
The SciCord Solution provides Document and Sample Management capabilities for SciCord generated 

Documents and Samples. Document and Sample management includes support for authenticated electronic 

signatures and controlling the review and approval processes. 
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Document Life Cycle 

The Life Cycle (Workflow) is determined by the user at the creation of the Document by selecting a Review 

Classification from the drop-list, however, the workflow may be changed afterwards by selecting the 

Document and then selecting the ‘Modify Status’ in the Documents or MyDocuments toolbar. Only a user 

with one of the Document_ReviewClassUpdate permissions is allowed to modify the Document workflow. 

 

 

Review Classifications  

 

 

 

 

 

Below is an example of each Document Workflow (Review Classification) 
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Sample Life Cycle 

As part of the Sample Type configuration, the Sample Type will have a default Review Classification 

(Workflow) upon creation. This Workflow may be changed only by a user with one of the 

Sample_ReviewClassUpdate permissions. To do so, the User would have to select the Sample in the 

Sample/MySample View and then select the ‘Modify Status’ button in the toolbar. From the Sample Status 

dialogue, the user will be able to modify the workflow. 

 

 

 

 

 

 

 

 

 

 

Below is an example of each Sample Workflow (Review Classification) 
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Electronic Signatures 
The Document/Sample Editor supports in-line management of digital Signatures for Author(s), Reviewer(s). 

A Signatures tab in the subpanel displays all signatures applied to the Document, including final Approval 

signatures of Documents with ‘PeerReviewApprove’ classification and ‘Complete’ status. 

 

Self-Review 
The Self Review workflow process includes the Document or Sample Creation, InProgress, and Complete 

phase. A Document or Sample may also be Cancelled or a Rework Requested. A Sample may be set to 

‘Available’  

By selecting ‘Set Status’ besides ‘Complete’, or any of the phases (if available) the Document will be in 

Complete Status. 

 

 

 

Below are images of the Workflow for a SelfReview Document and Sample. 
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Self-Review Document          Self-Review Sample 

  

*Note: Samples include an ‘Available’ phase in their Life Cycle. 

 

Peer Review 
The Peer Review workflow process includes the Document or Sample creation, InProgress, Review 

(ReviewAssigned), and Completion. A user may also choose to set the Document or Sample to Cancelled, or 

have the Document or Sample be Reworked (ReworkRequested). 

If the user were to select the ‘Set Status’ icon besides the Cancelled text, the Document will be in a 

Cancelled state. If the user would select the ‘Reviewer’ then the user would be able to select from a 

dialogue box, the Reviewer who would Review the Document. 
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Below are images of the Workflow for a Peer Review Document and Sample. 

  

Sample in Review Mode  
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Document in Review Mode 

When a Reviewer opens a Document for Review, they will notice several symbols within the Document 

related to their Review.  

   - The visible entry in the cell is the initial entry. 

   - The visible entry in the cell is not the initial entry and the history of the cell should be reviewed        

using the History subpanel. 

The Review may also view the subpanel Review Alerts tab, which highlights events requiring attention for 

the current Document. Examples of Review alerts are: Unlocking a cell, Balance not stable at time of 

recording, Balance not checked on day of usage, Instrument Calibration past due date at time of recording, 

or Document Template not validated at time of Document Creation. 

 

Peer Review Approve 
The typical PeerReviewApprove workflow process for a Document or Sample would include the Document 

or Sample creation, InProgress phase, ReviewAssigned, and ApproveAssigned. At any point a User may 

Cancel or assign the Document or Sample to ReworkRequested. 

The green depicts which stage of the workflow process (Reviewed) that the Document or Sample (Rework 

Requested) is on. In this example the Document is in the ApproveAssigned phase of the workflow process.  

Below are images of the PeerReviewApprove workflow for a Document and Sample.    
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Document in PeerReviewApprove   Sample in PeerReviewApprove 

 

 

Document Review 

Documents that are assigned to the user for review may easily be viewed in the MyReview View. The default 

filtering of this View is Status: ReviewAssigned and Reviewer: the user’s name. If there is a need, the user 

may change these default settings to include other users as well.  

From the MyReview view the user can select a Document and then click on the ‘Open Document for 

Review’, , icon. After selecting the icon, the Document will open and be able to be Reviewed. Also, the 

User may view either the Documents or MyDocuments view and, looking at the icon column, determine 

whether a Document is in Review status by observing the ‘Open Document for Review’ icon. If the 

Document is in Review status, only the user who has been assigned to Review will be allowed to access the 

Document for Review. 
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SciCord Icons and their Meanings 
 
SciCord 
Icon 

SciCord Icon Meaning 

 
Create a Document 

 

 
Open Document for View/Read Only Mode 

 
Open Document for Edit 

 
Clone a Document 

 
Review a Document 

 
Modify Document Status 

 
The Review Classification is set to Approve Assigned 

 
The Review Classification is set to Review Assigned 

 
Document is In Progress 

 
The Document is Cancelled 

 
Rework Requested Document 

 
The Document is Complete 

 
Unlock a Document/Sample 

 
The Document/Sample is locked 

 
Refresh the SciCord Client 

 

Fetch All 

 

Duplicate View 

 
Export View or Save this Document as a Local Excel File 

 
Bookmark - Add to My “x” View, where x is any view 
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Bookmark - Remove from My “x” View, where x can be any view 

 
Add to Groups 

 
Remove from Groups 

 
Message Alert 
 

 
New Message 

 
Read Message 

 
Dismiss Message 

 
Create a Sample 

 
View Sample 

 
Edit Sample 

 
Clone Sample 

 
Review Sample 

 
Modify Sample Status 

 
Sample Status is In Progress 

 
Sample Status is Available 

 
Sample Status is Cancelled 

 
Sample Status is Rework Requested 

 
Sample Status is Review Assigned 

 
Sample Status is Approve Assigned 

 
Sample Status is Complete 

 
Print Labels for Selected Samples 

 
Open Sample Inventory 

 
Open Inventory Calendar 

 
View Sample Work Requests 



 
SciCord ELN/LIMS Client User Guide - Beryllium R2.1.x 
Sep 28, 2022 

 

Page 98 of 103 

 
Delete Sample Work Requests 

 
Close and Save Changes 

 
Open the Sample Work Request Calendar 

 
Open Sample Specifications 

 
Add Sample Specification 

 
Clone Sample Specification 

 
Close View 

 
Move a View in the View pane up  

 
Move a View in the View pane down 

 
Create or Add a new navigation view  

 
Home Dashboard 

 
Bulk Remove/Delete 

 
Delete View 

 
Rename a View/Document/Sample 

 
Set Tags 

 
Documents View 

 
MyDocuments View 

 
Samples View 

 
MySamples View 

 
Data Files View 

 
MyDataFiles View 

 
Groups View 

 
Inventory Requests View 

 
Messages View 
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Resources View 

 
MyResources View 

 
Reports View 

 
MyReports View 

 
Results View 

 
Sent Messages 

 
Specifications View 

 
Work Requests View 

 
Templates View 

 
MyTemplates View 

 
User View 

 
MyUsers View 

 
MyApprove View 

 
MyReview View 

 
Download files 

 
Upload files 

 

Data File Properties 

 
Delete Data File 

 
Data File History 

 

Data File Signature 

 
Settings 

 
Open SciCord Portal 

 
Open Resource Read Only 
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Open Resource for Edit 

 
Print Labels for Selected Resource 

 
Open Resource Inventory 

 
Resource in Review Status 

 
Resource Status is Complete 

 
Resource Status is Cancelled 

 
Help  

 
Login 

 
Logout 

 
Save 

 
Search 

 

Copy Worksheet 

 

Delete Worksheet 

 
Rename Worksheet 

 
Reorder Worksheets 

 
Toggle Worksheet Headers 

 
Show Gridlines 

 
Names Manager 

 

Delete Shape 

 
Copy  

 
Paste 

 
Symbols 

 
Insert Signature 
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Insert File Attachment 

 
Create New Worksheet 

 
Import from a Workbook 

 
Insert Textbox 

 
Insert Line 

 
Insert Image 

 
Insert Chart 

 
Insert Date 

 
Insert Analyst 

 
Insert Note 

 
Bold 

 
Italicize 

 
Underline 

 
Left Justify 

 
Center Justify 

 
Right Justify 

 
Text Color 

 
Word Wrap 

 
Cell Fill color 

 
Cell Border 

 
Cell Format 

 
Shrink Columns 

 
Expand Columns 

 
Shrink Row 
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Expand Row 

 

Insert new rows or columns 

 
Delete rows or columns 

 
Review Marks 

 
Change Marks 

 
Toggle Subpanel 

 
Barcode Scanner 

 

Display Calendar 

 

Stopwatch 

 
Open URL 

 

Cell Editor 

 
Switch User 

 

Print Entire Workbook, Current Page, or Selection 

 

Print Preview for Workbook, Current Page, or Selection 

 

Printer Page Setup 

 
Scheduling 

 
Hide 

 
Manage Reports 

 
View Report Details 

 
Launch Report 

 
Redo 

 
Settings 
 

 
Columns   
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Filters  

 
Close Current Page 

^ Expand or Collapse Tools Panel 

 
Review Selection– provides the Reviewer the ability to ‘Review’ each cell in a 
worksheet individually. By selecting the icon, the Review symbol will be 
removed. 

 
Review Worksheet– provides the Reviewer the ability to ‘Review’ each 
worksheet in totality. By selecting the icon, the Review symbols will be removed 
from the worksheet. 

 
‘Mark Document as Reviewed’ – provides the Reviewer the ability to ‘Review’ 
the workbook in totality. By selecting the icon, the Review symbols will be 
removed from all areas of the workbook. 

 

 

 


